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Chapter 1: Getting Started with 
Xenofex 2

Welcome
Welcome to Xenofex 2, a set  of 14 phenomenal 
plug-in effects for Photoshop and other 
compatible graphics host  programs.

Please take some t ime to explore this manual; it  
contains information essential to gett ing the 
most out  of Xenofex 2. Take a few minutes to 
familiarize yourself with the preview window 
and user interface. Soon you’ll be ready to dive 
in and experiment with Xenofex 2

This chapter contains the following sections:

• “What’s New” on page 1

• “Important  Symbols” on page 2

• “Host Requirements” on page 2

• “System Requirements” on page 3

• “Macintosh Installat ion” on page 3

• “Windows Installat ion” on page 5

• “Registering Xenofex 2” on page 7

• “The Xenofex 2 User Interface” on page 7

• “Keyboard Shortcuts” on page 12

What’s New

For Users Upgrading from Xenofex
Note: If this is the first  version of Xenofex 
you’ve owned, skip ahead to “Important 
Symbols” on page 2.

This section lists the new features, improve-
ments, and new filters added to Xenofex since 
version one. Detailed discussions of new features 
can be found in the relevant  sections of the 
manual. 

Five New Filters
The following filters are new to Xenofex 2:

• “Burnt Edges” on page 13—Easily scorch 
photos.

• “Classic Mosaic” on page 16—Convert  photos 
into mosaics with a single click.

• “Cracks” on page 23— Simulate fault  lines, 
cracks, erosion or fissures.

• “Rip Open” on page 46—Tear holes in the 
shape of text  and selections.

• “Shatter” on page 48—Explode images into 
lit t le pieces that  fly off the page. 
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New User Interface
We gave Xenofex 2 the Eye Candy 4000 interface. 
Simple and uncluttered, with hundreds of 
presets, unlimited undos, keyboard shortcuts, a 
before/ after feature and more, the new user 
interface is a huge improvement. For more 
details, see “The Xenofex 2 User Interface” on 
page 7.

Existing Filter Improvements
Here are just  a few of the improvements to 
exist ing filters:

• Constellat ion—Now highlights edges for more 
realism, and adds new features, such as 
Twinkle.

• Crumple—More realist ic, with a seamless t ile 
option, and expanded distort ion features.

• Electrify—Tabbed interface organization.

• Flag—More realist ic simulat ion with better 
control over Flag attachment points and wind 
direction.

• Lightning—Now aim your lightning bolts by 
specifying beginning and end points.

• Litt le Fluffy Clouds—Now create perspective 
clouds with improved sky color controls, 
seamless t iling and more.

• Puzzle—Now knock out puzzle pieces!

• Stain—More realist ic, with ring stain option.

• Television—More realist ic, with vert ical shift  
simulation.

Important Symbols
Pay close attention when you see a 
warning symbol in the manual. 
Warnings point out  bad technique or 
improper use of the Xenofex 2 filters. 

Don’t  shoot  yourself in the foot.

Tips provide useful techniques and 
t ime-saving steps that  increase your 
productivity when using Xenofex 2.

Host Requirements
Xenofex 2 is a plug-in; you must use it  with one 
of the following compatible host  programs:

Macintosh
• Adobe Photoshop 6 or 7 

• Adobe Photoshop Elements 2.0 

• Macromedia Fireworks MX or later

Windows
• Adobe Photoshop 6 or 7

• Adobe Photoshop Elements 2.0 

• Macromedia Fireworks MX or later

• Paint  Shop Pro 7.0 or later

We are constantly test ing new programs for 
compatibility with Xenofex 2. For information 
about other compatible host  programs, please 
check our Web site: ht tp:/ / www.alienskin.com.
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System Requirements

Macintosh
• PowerPC processor

• Macintosh System Software 9 or later; OS X 
10.1 or later

• 64 MB or more of physical RAM

Windows
• Pentium II-class processor

• Windows 98/ 2000/ Me/ XP
Note: Windows NT is not supported.

• 64 MB or more of physical RAM

Macintosh Installation
The following boxed section contains 
important information about 
installing Xenofex 2 on systems 
running Macintosh OS X. 

Note: You may skip the following boxed section 
if you are installing on an earlier version of 
Mac OS.

MACINTOSH OS X INSTALLATION ISSUES
Read this section carefully if you are installing 
Xenofex 2 on systems running Macintosh OS X.
Installing with Administrator Privileges 
To install Xenofex 2, your Mac OS X user account 
must have administrator privileges. The Xenofex 2 
installer, like most installation programs, will need 
to write files to protected folders on your com-
puter. For information on configuring your user 
account for administrator privileges, talk to your 
IT guy or consult your operating system’s user 
manual.
Installing Xenofex 2 as a Classic Application 
I f you are running OS X and want to install Xenofex 
2 into a host that runs under Classic mode—such 
as Photoshop 6 or 7—you will need to run the 
installer under Classic mode, also. I f the installer 
runs under OS X, it assumes that your host is a Car-
bonized application and saves the registration 
information differently than when it runs under 
Classic. I f you try to use Xenofex 2 in Classic mode, 
the registration information will not be present; 
you’ll get an error, and will be unable to use the 
filters.

To force the Xenofex 2 installer to run in Classic 
mode, highlight the program icon and select Show 
Info under the File menu. Next, check the check 
box item Open in the Classic environment. Close 
the Info dialog and double click on the program. 
This will bring up the Classic environment (if it 
isn’t already up) and run the installer.
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Before installing Xenofex 2, shut 
down your graphics program 
(Photoshop or Fireworks). This is 
necessary because host  programs 

only recognize new filters when start ing up. 

Insert  the Xenofex 2 CD into your computer. If 
you purchased an electronic version of Xenofex 
2, locate the Xenofex 2 installat ion program 
that you downloaded from the online store. 
Double-click the Install Xenofex 2 icon. After 
the splash screen, the installer will display the 
Readme file for Xenofex 2. Click Next after you 
have carefully read the Readme file. The installer 
will then display the License Agreement. After 
reading this, click Accept.

Next you will be asked to enter your name, 
company name (optional) and registrat ion code 
in the following dialogue box. 

Your registrat ion code is the 12-letter code 
located on a st icker on the inside front cover of 
the manual. If you purchased an electronic 
version of Xenofex 2, the 12-let ter code, visible 
during the download process, is included in the 
email invoice or in an electronic users license 
file with your download. We strongly suggest  
you store this code in a safe place for future 

installat ions. We also recommend registering the 
software with Alien Skin Software, either via our 
Web site or by mailing us the registrat ion card. 
If you ever need a replacement code, 
replacement software, or technical support , you 
will need to be registered with us.

After you enter your registrat ion code, you will 
see the main installat ion screen.

Our installer will now search for Photoshop 6 or 
7. If you are installing into Photoshop, highlight 
<Drive> : Applications : Adobe Photoshop (6 
or 7)  : Plug-ins and click OK to install Xenofex 
2. The installer will find the Photoshop plug-ins 
folder and install Xenofex 2 there.

If you are installing to another graphics host , 
you should click the Choose another install 
location button.

It  is important  that  you now locate your 
graphics program’s plug-in folder. If you do not 
choose the proper plug-in folder, then the filters 
will not  show up in your graphics program’s 
Filters menu.
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Browse your hard disk until you find the appro-
priate Plug-ins folder. Highlight the folder and 
click the Choose button to return to the main 
installat ion screen. The Xenofex 2 files will be 
copied to your hard disk.

If you are not sure where to install Xenofex 2, 
consult  your graphics program’s manual. 
Photoshop users can check for the plug-in 
location by selecting the Plug-In option under 
the Preferences sub-menu of Photoshop’s File 
menu. The Plug-ins folder is usually located in 
the Photoshop folder.

Rerun the installer if you wish to install Xenofex 
2 into other graphics programs.

Windows Installation
The following boxed section contains 
important information about 
installing Xenofex 2 on systems 
running Windows 2000 and 

Windows XP. 

Note: You may skip the following boxed section 
if you are installing Xenofex 2 on a Windows 98 

or Windows ME system.

Before installing Xenofex 2, shut  
down your graphics program 
(Photoshop, Paint Shop Pro or 
Fireworks). This is necessary because 

host  programs only recognize new filters when 
start ing up. 

Insert  the Xenofex 2 CD into your computer. If 
you purchased an electronic version of Xenofex 
2, locate the Xenofex 2 installat ion program 
that  you downloaded from the online store. Run 
the program Setup.exe. After the splash screen, 
the installer will display the Readme file for 
Xenofex 2. Click Next after you have carefully 
read the Readme file. The installer will then 
display the License Agreement. After reading 
this, click Accept.

WINDOWS INSTALLATION ISSUES
Installing with Administrator Privileges  
To install Xenofex 2, your Windows 2000 or Win-
dows XP user account will need to have adminis-
trator privileges. The Xenofex 2 installer, like most 
installation programs, will need to write files to 
protected folders on your computer. For informa-
tion on configuring your user account for such 
privileges, consult with your system administrator 
or with your operating system’s manual.
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Next you will be asked to enter your name, 
company name (optional) and your registrat ion 
code.

Your registrat ion code is the 12-letter code 
located on a st icker on the inside front cover of 
the manual. If you purchased an electronic 
version of Xenofex 2, the 12-let ter code, visible 
during the download process, is included in the 
email invoice or in an electronic license file with 
your download. We strongly suggest  you store 
this code in a safe place for future installat ions. 
We also recommend registering the software 
with Alien Skin Software, either via our Web site 
or by mailing us the registrat ion card. If you 

ever need a replacement code, replacement 
software, or technical support , you will need to 
be registered with us.

Next, our installer will search for all graphics 
programs on your computer that are compatible 
with Xenofex 2 and will display them in a list .

Select  one program (you can only install into 
one graphics program at a t ime) and click OK. 
The installer will look for the correct  plug-ins 
folder for the selected program and install 
Xenofex 2 there. 
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If you wish to install Xenofex 2 into a program 
that’s not listed in the Select Host list , click the 
Choose Another Location button to bring up 
the manual Select Destination Directory 
window. Browse through the file list  until you 
find the desired folder and click OK. If you are 
not  sure where to install Xenofex 2, consult  your 
graphics program’s manual.

Photoshop users can check for the plug-in 
location by selecting the Plug-In option under 
the Preferences sub-menu of Photoshop’s File 
menu. The Plug-ins folder is usually located in 
the Photoshop folder.

Rerun the installer if you wish to install Xenofex 
2 into other graphics programs. 

Registering Xenofex 2
Please take a moment to register your copy of 
Xenofex 2 with us. Note that  if you purchased 
Xenofex 2 directly from Alien Skin Software, via 
phone, fax, email or the purchase page at  our 
Web site, then you are already registered with 
us. You only need to register if you purchased 
Xenofex 2 through a catalog, store or other 

reseller. Registering will help speed up any tech 
support  assistance and allows us to inform you 
of any bug fixes or updates to the software. We’ll 
also be able to notify you of special discounts on 
other Alien Skin products.

You can register via the World Wide Web during 
the installat ion process (see either “Macintosh 
Installat ion” on page 3 or “Windows Instal-
lat ion” on page 5). 

If you don’t  have access to the World Wide Web, 
you can register by completing and mailing the 
registrat ion card included with every hard copy 
of Xenofex 2. Mailing the card is free in the 
United States.

The Xenofex 2 User Interface

Menus
Command menus are accessible when you call up 
each of the Xenofex 2 filters. Macintosh users 
will see the menus in place of their usual menu 
bar. Windows users will see the menus at  the top 
of the filter preview window.

Edit Menu
This menu allows you an unlimited number of 
Undo’s and Redo’s in the preview window. If you 
experiment with the sliders, and find that  you 
prefer a previous group of sett ings, simply use 
the Undo command in the Edit menu, or use 
Command-Z (Control-Z on Windows machines) to 
back up as many t imes as necessary.
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The Edit menu also allows you to Copy, Cut, 
Paste, and Delete numerical values from 
parameter fields.

Filters Menu
This menu allows you to switch between filters 
from within the preview. Photoshop users note 
that  if you switch between filters from within 
the Xenofex 2 preview, the Actions, History, and 
Last  Filter Used functions will record the filter 
you init ially selected.

View Menu
This menu allows you to zoom the preview in 
and out. You can also view all of the layers in 
your image using the Show All Layers 
command. 

Note: Due to a limitat ion in Photoshop, 
choosing Show All Layers in the preview 
window will show all of the visible layers in your 
image, even if those layers are above the current 
(working) layer in the Layers palette. As a 
result , your effect  may be invisible in the filter 
preview window.

In the preview, you will also see the current  
working layer below the filter effect . Again, this 
is a limitat ion in Photoshop, not  Xenofex 2, but  
it  can be misleading so we recommend tempo-
rarily turning off Show All Layers in cases 
where the current working layer is below other 
opaque layers in your composit ion.

Note: Show All Layers will be grayed out and 
unavailable in hosts other than Photoshop.

Settings Menu
This menu allows you to name, save, and delete 
your own sett ings, as well as use the presets that  
we include with each filter. You can also reset  a 
filter to its factory default  set t ings from this 
menu. Another way to reset  the sett ings is by 
pressing the F5 key (Windows) or the Command-
R key sequence (Macintosh). 

Help Menu
The enhanced Help menu allows you to access 
context-sensit ive (filter-specific) help from 
within a filter window. You can access filter-
specific help by pressing the F1 (Windows) or 
Help (Macintosh) key within any filter interface.

The enhanced Help menu contains user manual 
documentation to help you better use the 
Xenofex 2 filters. You can also access the Alien 
Skin home page from the Help menu.

To access a Table of Contents for the online help, 
click Help > Contents in the Xenofex 2 user-
interface.



9

The Filter Window
Take a look at  the Crumple filter window. The 
Macintosh and Windows versions are 
functionally identical.

The Windows filter window looks almost exactly 
the same, with the addit ion of the Xenofex 2 
menu bar at  the top left .

A: The Slider Controls
Slider controls and radio buttons appear along 
the left  side of the filter window. 

B: Thumbnail Navigation
The thumbnail image above the preview window 
allows you to move the preview anywhere in 
your image with a single click. The movable red 
box displays the area of your image visible in the 
preview window.

E

B
C

D

F GH

A
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C: Move, Zoom, Show Original, and Arrow Buttons
The Move (hand) and Zoom (magnifying glass) 
tools, and Show Original button are found 
above the preview window. Click the hand to 
enable the Move tool, then click and drag to 
move around the preview image.

The Move and Zoom Tools

Click the magnifying glass to enable the Zoom 
tool. Click to zoom into your image; Option-click 
to zoom out (Alt-click for Windows users). 
Double-clicking the Zoom tool at  any t ime 
resets the preview window to 100% magnifi-
cation.

The Show Original button enables you to toggle 
back and forth between the filtered and unfil-
tered versions of your image. Just  click and hold 
the button to view the unaffected image. 
Release the button when you want to view your 
image with the effect .

The Show Original Button

The Arrow button enables In Preview controls in 
the Puzzle and Lightning filters. See the Puzzle 
or Lightning chapters for more details.

The Arrow Button

D: OK and Cancel Controls
Clicking the OK button applies the filter with 
the current  set t ings. Clicking Cancel closes the 
filter window without applying the effect .

E: Preview Window Area
Preview the effect  on your image here. The 
preview area can be resized by clicking and 
dragging the bottom right-hand corner of the 
filter window. Windows users can also click and 
drag the bottom of the window.

F: Render Status Bar
The rectangle to the left  of the magnification 
indicator is the Render Status bar. As an effect  
is being rendered in the preview, this rectangle 
displays the amount of rendering that  has been 
completed.

G: Magnification Indicator
The current level of magnification is shown to 
the right of the render status bar at  the lower 
right corner of the filter window.

H: Mouseover Help String Area
All elements in each filter window have 
mouseover help text  associated with them. This 
help text  appears at  the bottom left  of the filter 
window whenever you move your cursor over a 
user interface element.

A Note About Sliders
A variety of sliders are used in Xenofex 2. Each 
one allows you to enter a numeric value or click 
and drag the slider to get  the desired effect .
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Note that  you can use the slider, enter a numeric 
value, or use the up and down arrow keys to 
change the value of filter controls. You can also 
adjust  slider set t ings by using the up and down 
arrow buttons to the right  of the sliders.

Using Settings
The Settings menu in each filter window allows 
you to save and manage the presets that  are 
included with each filter. You can also create 
your own set t ings.

How to load a preset
To use a preset  included with a filter, simply 
open the Settings menu and select  the name of 
the desired sett ing from the list .

How to Save and Manage Settings
If you have a filter sett ing you’d like to save for 
later use, click Save... in the Settings menu. A 
dialog box appears, asking you to name the 
sett ing. Type in a name, using only let ters 
and/ or numbers, and click OK. The sett ing will 
appear in the Settings menu immediately.

To rename a sett ing, click Manage... in the 
Settings menu. Highlight the set t ing you wish 
to edit  and click Rename. Type in the new name 
and click OK.

To delete a set t ing, click Manage... in the 
Settings menu. Highlight the set t ing you wish 
to delete from the list  and click Delete.

You will not  be able to undo delet ing a set t ing. 
Be certain you want to delete any sett ing before 
doing so; the delete is permanent.

Resetting to Factory Default
Every filter has a basic factory default  set t ing. 
The Reset to factory default command in the 
Settings menu will display a preview with the 
filter’s default  set t ing. If you are bogged down 
in a quagmire of complex slider combinations, 
use the F5 (Windows) or Command-R 
(Macintosh) key to reset the current preview to 
the filter’s factory default  set t ing. 

Enjoy the Filters!
That’s it  for the opening section. We’ve designed 
Xenofex 2 to be a tool that’s both fun and easy 
to use. We hope you enjoy using the filters.
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Keyboard Shortcuts
Macintosh Windows

Next Editable Text Field Tab Tab

Previous Editable Text Field Shift  + Tab Shift  + Tab

OK Return Return

Cancel Escape Escape

Undo Command-Z Control-Z

Redo Command-Y Control-Y

Cut Command-X Control-X

Copy Command-C Control-C

Paste Command-V Control-V

Next Filter Command- ] Control- ]

Previous Filter Command- [ Control- [

Zoom In Command- + Control- +

Zoom Out Command- - Control- -

Actual Pixels Alt  + Command + Zero Alt  + Control + zero

Restore Default  Sett ings Command-R F5

Switch to Move Tool (hand) H H

Switch to Zoom Tool Z Z

Switch to In Preview Controls A A

Zoom In (with zoom enabled) Mouse Click Left  Mouse Click

Zoom Out Option + Mouse Click Alt  + Mouse Click

Zoom to Actual Pixels Double-click Zoom Tool Double-click Zoom Tool

Increase/ Decrease Slider by 1 Up/ Down Arrow Up/ Down Arrow

Increase/ Decrease Slider by 10 Shift-Up/ Down Arrow Shift-Up/ Down Arrow
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Chapter 2: Burnt Edges

Burnt Edges simulates the effect  of burning the 
edges of a piece of paper, or burning a hole into 
paper, and then putt ing the flame out. Burnt 
Edges can be used with any select ion shape, 
including text. By using different  burn colors, 
you can create many different  effects. Check out 
the Burnt  Edges presets to see some of the many 
effects you can create.

Using Burnt Edges
1 Using a select ion tool, such as the type mask 

tool, or the lasso, select  the object  or area that  
you wish to burn. Or, to burn the edges around 
an entire image, run the Burnt  Edges filter 
with no select ion. 

2 Run the Burnt  Edges filter.

3 Adjust  the filter controls to taste.

4 Click OK.

5 Enjoy.
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Control Descriptions
Contract/ Expand Selection Use this slider to 
contract  or expand your original selection from 
within the Xenofex 2 user interface. 

Burn Width Controls the thickness of the burnt 
area around your selection. 

Roughness Controls the roughness of the burnt  
edge; higher values produce an increasingly 
jagged edge.

Hollow Edges Selecting this check box hollows 
out the fringes of the burnt  edge.

Top: Hollow edges disabled and burn inside enabled on 
type.

Bottom: Hollow edges enabled.



15

Burn Inside Select  this option to burn a hole 
into the selection.

Burnt Edges with Burn Inside selected.

Burn Color The burnt  edges can be any color 
you like. Clicking in this box awakens your 
slumbering color picker.

Fill Inside Burn The following three options 
determine how Burnt  Edges fills an area which 
has been burned away. 

Fill with solid color Fills burned away areas 
with the color chosen by the Fill Color picker.

Keep Original Image Preserves the original 
image in areas which have been burned away. 

Make Selection Transparent Fills burned away 
areas with transparency. Any underlying image 
layers will show through the burned out areas. 
This option is disabled when your image is in the 
background layer.

Overall Opacity Controls the opacity of the 
burned edge effect . 

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.



16

Chapter 3: Classic Mosaic

Classic Mosaic converts any image into a realist ic 
t iled mosaic. Classic Mosaic is part icularly 
effective because of it’s edge detecting features. 
Tiles align themselves to curved shapes, such as 
the outlines of a face, to simulate the visual 
characterist ics of ancient  Greek mosaics. Classic 
Mosaic is an extremely simple filter to operate. 
In most  cases, you’ll run it  on an entire image; 
so a select ion isn’t  even necessary.

Using Classic Mosaic
To get great results with Classic Mosaic, choose 
images to be used with the filter wisely. Here are 
some guidelines for choosing an image that  will 
work well with Classic Mosaic:

• Choose large images with strongly contrast ing 
colors.

• Adjust  the contrast  levels in your image to 
improve results.

• If you want to work with text , use type large 
enough to handle being rebuilt  as blocks.
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Now that  you’ve chosen the right image, Classic 
Mosaic is a snap:

1 Run the Classic Mosaic filter.

2 Choose an appropriate t ile size. Tiles that  are 
too large obscure details of the original image, 
but t iles that  are too small don’t  look like t iles. 

3 Select  a grout width that  strikes your fancy. 
Grout that  is too wide confuses the original 
image.

4 Select  the edge sensit ivity that  preserves just  
the right amount of detail from your original 
image.

5 Click OK.

6 Enjoy.

Control Descriptions
Tile Size Controls the size of the t iles that  
compose your mosaic. Higher values yield larger 
t iles.

Grout Width Specifies the width of the space 
between tiles, relat ive to the t ile size. Larger 
values increase the spacing between t iles.

First image above: Grout Width 20.
Second image: Grout Width 75
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Edge Sensitivity Higher values forces the t iles 
to follow the details of an image more closely.

Grout Color Grout can be any color you like. 
Clicking in this box awakens your slumbering 
color picker.

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Tips
The following t ips will help you get  the best  
results when using Classic Mosaic:

Use the contrast  adjustment tools in 
your graphics host  to strengthen 
contrast  levels in your image. This 
practice helps Classic Mosaic detect  

and place t iles along edges more accurately.

Crumple your image before running 
Classic Mosaic to add interesting 
variations to the colors and shape of 
t iles.
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Chapter 4: Constellation

Constellat ion reconstructs images as starlike 
points of light. Imagine the constellat ion effect  
as an overlay of the original image, where each 
star takes its color from the image lying 
beneath. Constellat ion also detects the edges of 
objects in your images to better accentuate 
shapes in the effect . You can then choose to fill 
the areas between the stars with the original 
image, color or transparency. 

Constellat ion also provides a wide range of kalei-
doscopic textures and effects; we strongly 
recommend you experiment with this filter, 
start ing with the presets, to discover all that  it  
can do.

Using Constellation
Constellat ion is typically used on entire images, 
but  the filter also works great  with select ions 
and text . 

1 Select  the image or selection that  you want to 
transform.

2 Run the Constellat ion filter.

3 Tweak the control sliders until you are 
satisfied with the results.

4 Click OK

5 Enjoy.
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Control Descriptions
Star Size Controls the size of the stars that  
make up your constellat ion. Higher set t ings 
yield larger stars.

Size Variation Controls the irregularity of star 
sizes in the effect . Higher values produce more 
inconsistently sized stars.

Edge Star Density Controls the number of stars 
placed around detected edges in your image. 
Higher values increase the frequency of edge 
stars. Use higher densit ies to accentuate the 
outline of a face, for example.

Top to Bottom: The effects of increasing edge star density.
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Overall Star Density Controls the number of 
stars placed throughout the image. Higher 
values place more stars.

Overdrive Controls the brightness and 
saturation of the stars’ light  and color. Higher 
values make the stars brighter and whiter.

Twinkle Amount Adds sparkling spires of light  
that radiate outward from the largest  stars. The 
values are a percentage of the total. If you select  
10, 10 percent of the largest  stars will twinkle.

Twinkle Rotation Specifies the angle of 
rotation at  which the spires radiate from the 
stars. Enter a numeric value or click and drag the 
control knob to change the value.

Background Fill The following three options 
determine how Constellat ion fills an area which 
has been filled with stars. In a background layer, 
you can fill with the original image or a solid 
color or the original image. In any other layer, 
you can fill with transparency, a solid color, or 
the original image.

Fill with solid color 
Fills the areas between stars with the color 
chosen using the Fill Color picker.

Applying Constellation to photographs works great! This 
example really shows off the advanced edge detection ca-
pabilities in Constellation.

Keep Original Image
Preserves the original image in areas beneath 
the stars and yields a sparkly overlay of the 
original image.
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Make Selection Transparent
Fills areas between stars with transparency. Any 
underlying image layers will show through the 
transparency. This option is disabled when your 
image is in the background layer.

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Tips
Say you have a picture of a rapper 
with gold teeth. By select ing just  the 
teeth, then choosing the Keep 
original image fill option, and 

applying Constellat ion, you add the perfect  
“bling-bling” effect!
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Chapter 5: Cracks

Cracks simulates the fault  lines, cracks, erosion 
or fissures that  one might  see in an aged solid 
stone surface. Cracks works great  with text  and 
other objects alone in layers.

Using Cracks
Cracks is best  used on objects in layers. For the 
best  results, do not apply to entire images.

1 Using a selection tool, preferably the lasso, 
make a selection around the object  or text  
that  you want to crack.

2 Run the Cracks filter.

3 Tweak the controls to taste.

4 Click OK.

5 Enjoy.

Control Descriptions
Crack Length Controls the length of the cracks. 
Larger values produce longer cracks.

Crack Spacing Controls the average distance 
between cracks in your selection. Lower values 
reduce the amount of space between cracks, 
thus increasing the density.

Crack Width Larger values make the cracks 
wider.

Crack Depth Larger values make the cracks 
appear deeper.

Edge Roughness Controls the roughness of the 
outer edges of the cracks; higher values yield a 
rougher, more eroded look.

Light Direction Controls the direction from 
which the light falls on your selection. Click and 
drag within the lighting control box to change 
the direction, or enter a numerical value 
between 0 and 360 degrees.
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Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.
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Chapter 6: Crumple

Crumple simulates the result  of balling up of a 
flat  object , such as a piece of paper, and then 
flat tening it  back out. Crumple works great  on 
entire images and discrete objects, such as text .

Using Crumple
1 Using a selection tool, make a selection 

around the object  that  you want to crumple. 
To apply Crumple to the entire image, make no 
selection at  all.

2 Run the Crumple filter.

3 Adjust  the control sliders until you have 
achieved the desired effect .

4 Click OK.

5 Enjoy.
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Control Descriptions
Crumple Size Controls the size of the creases in 
the crumpled paper.

Crumple Force Low values crumple the image 
less; higher values wrinkle the selection more. 
Note that  highly crumpled paper, combined with 
Distort Image covers less projected area than 
the original image.

Distort Image Select  the Distort Image 
checkbox to make your image adhere to the 
surface contours created by the crumple effect . 
When this checkbox is cleared, Crumple creates 
highlights and shading that  do not affect  the 

original image. This option also causes the edges 
of your selection to be drawn in. This space can 
either be transparent or filled with a solid color. 

The uppermost image is crumpled with the Distort Image 
option disabled. In the lower image, Distort Image is en-
abled. 

Seamless Tile Select  the Seamless Tile 
checkbox to create a crumpled rectangle that  
can be t iled with no seams. Selecting Seamless 
Tile disables Distort Image. 
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Background Color Chooses the solid color that 
fills in where the effect  does not cover the 
original image. This is only enabled in the 
background layer. In layers that have trans-
parency, the area around the effect  is simply 
erased.

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Direction Controls the direction from which the 
light  falls on your selection. Click and drag 
within the lighting control box to change the 
direction, or enter a numerical value between 0 
and 360 degrees.

Inclination Controls the angle formed by the 
light  and the page. Click and drag within the 
lighting control box to change the inclination, 
or enter a numerical value between 45 and 90 
degrees.

Highlight Brightness Controls the intensity of 
the shiny highlights appearing on areas facing 
the light.

Highlight Size Controls the size of the shiny 
highlights on areas facing the light; higher 
values yield larger highlights.

Highlight Color Use the color picker to choose 
any color for the shiny highlights.

Light Boost Increases the overall brightness of 
the image to compensate for any darkening due 
to lighting calculations.
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Chapter 7: Electrify

Electrify creates arcs of electricity branching out 
from a selection, object , or text . You have more 
control over the number, shape, direction and 
color of the arcs of electricity. 

Using Electrify
Note: Use Electrify to create arcing electricity 
around selections, text , and objects. Use the 
Lightning filter in photos to simulate (you 
guessed it) lightning.
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Since Electrify places arcs of electricity around 
an object , you must use the filter with a 
selection, or an object  floating in an empty layer 
with surrounding transparency. 

1 Select  the object  or text  that  you want to 
electrify.

2 Run the Electrify filter.

3 Adjust  the control sliders until you have 
achieved the desired effect .

4 Click OK.

5 Do a dance.

Control Descriptions

Basic Tab
Arc Spacing Specifies the distance between 
each arc. Lower values reduce the distance 
between arcs, thus increasing the total number 
of arcs.

Arc Length Controls the length of the arcs. 
Higher values yield longer arcs. Not all arcs are 
the same length, however. 

Arc Thickness Controls the width of each arc. 
Higher values make wider arcs.

Jaggedness Higher values increase the crooked 
movement of arcs. Lower values yield straighter 
arcs.

Branching Controls the number of branches 
each arcs forms; higher values generally yield 
more branching. Because branching is a random 
process, changing the Branching slider will 

sometimes have more effect  than others. 
Clicking Random Seed will sometimes create 
more branches when Branching doesn’t  seem to 
have much effect .

Branch Spread Controls how far apart  the 
branches are spaced; higher values increase the 
angle between branches.
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Radiate From Center Selecting this option 
makes all of the arcs move directly away from 
the center of the selection. When deselected, 
arcs will shoot outward at  a a 90 degree angle, 
relat ive to the selection.

Radiate from center is enabled in the lower fez. 

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed sett ing can produce dramatic 

changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Glow Tab
Glow Width Controls the diffuse glow around 
the arcs. Increasing this value spreads the glow 
over a wider area.

Glow Opacity Increasing this value yields a 
more solid and intense arc. 

Inner and Outer Color The glow at  the middle 
of each arc starts as the Inner Color and fades 
to the Outer Color as it  moves outward. Clicking 
in either box brings up a color picker dialog.
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Chapter 8: Flag

Flag uses shadows and highlights to simulate 
three-dimensional, windblown fabric or liquid 
surfaces. Flag quickly creates striking banners 
for the web. Intrepid users can even start  with 
non-rectangular shapes to make pennants or 
war-torn flags.

Using Flag
Apply Flag to objects in layers with transparency 
to get  the best  results. 

1 Place an object  in a layer, by itself, with 
background transparency.

2 Run the Flag filter.

3 Adjust  the filter controls to taste.

4 Click OK.

5 Enjoy.
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Control Descriptions
Simplified Mode Selecting this option disables 
most of the Flag controls making it  easy to 
create an idealized flag. To make a simple 
rectangular flag that  looks like it  is being blown 
from left  to right , check this box.

Shrink Shrink is a zoom lens for your flag. If 
parts of your flag fall outside of the viewable 
canvas, increase the Shrink value to zoom away 
from the flag.

Wind Strength Controls the speed of the air 
flowing over the fabric. Higher values create 
more ripples and cause the ripples to curve 
more.

Wind Direction Controls the direction from 
which wind blows across the flag. 

Realistic Distortion Controls the amount that  
rippling affects the apparent  dimensions of the 
flag. Lower values shrink the image less and 
preserve more original detail. Higher values 
realist ically shrink the flag. 

Top to bottom: Increasing Realistic Distortion shrinks the 
flag.

Attachments Controls which corners and edges 
are fixed. Each checkbox corresponds to a corner 
or an entire side of the flag. To hold a typical 
flag t ightly to the flagpole, turn on the middle-
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left  checkbox. To hold the flag more loosely, 
clear the middle-left  checkbox and turn on both 
the upper-left  and lower-left  checkboxes.

The flags above are held loosely to the poles, using only 
two corner attachments.

Background Color Chooses the solid color that 
fills the areas where the effect  does not cover 
the original image. This is only enabled in the 
background layer. In layers that have trans-
parency, the area around the effect  is simply 
erased.

Increase Contrast Boosts the lighting effect  on 
your flag, yielding brighter, harsher lighting.

Light Direction Controls the direction from 
which the light falls on your selection. Click and 
drag within the lighting control box to change 
the direction, or enter a numerical value 
between 0 and 360 degrees.

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Tips
It  is easy to make non-rectangular 
flags. For instance, to make a baseball 
pennant, use the following steps:

1 Create a rectangular image in a layer with 
transparency.

2 Trim it  to a triangular shape.

3 Run Flag and, voila, you have a pennant!
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To make a flag look like it  has been 
through a batt le, rough up the edges 
and add bullet  holes before applying 
the Flag filter. Bullet  holes are easy to 

make with the Xenofex 2 filters Burnt Edges or 
Rip Open. 
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Chapter 9: Lightning

Lightning renders realist ic arcs of lightning in 
digital photos and composit ions without wait ing 
for a thunderstorm. You can specify beginning 
and endpoints to steer lightning bolts. Control 
over the color, branching and spread of the arcs 
of lightning add to the versatility of the effect . 

Using Lightning
Lightning renders a single arc of electricity 
inside of a selection. Use the Lightning filter to 
simulate (you guessed it) lightning bolts in 
photos. Use Electrify to create arcing electricity 
around selections, text , and objects.

1 Run the Lightning filter.
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2 Specify the beginning and endpoints of your 
lightning bolt .

3 Tweak the other control sliders until you have 
achieved the desired effect .

4 Click OK.

5 Enjoy.

Control Descriptions

In Preview Controls
Click the Arrow button to posit ion the 
beginning and endpoints of your arc of 
lightning. When you activate the In Preview 
control, a new cursor and two crosshairs appear 
in the preview window. With the cursor, simply 
click and drag the crosshairs to wherever you 
prefer. You can even drag them outside of the 
image.

Crosshairs—Click with the
cursor and drag to aim your 

Click the arrow to 
activate the In Preview control.

The In Preview control cursor.

lightning.
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Basic Tab
Taper Main Arc. Select  this option to taper the 
arc of lightning from thick to thin. If this option 
is not  selected, the primary arc maintains an 
even thickness along its length and each end is 
terminated by a glowing flash.

Arc Thickness. Controls the width of the arc. 
Higher values make wider arcs.

Jaggedness. Higher values increase the crooked 
movement of arcs. Lower values yield straighter 
arcs.

Branching Controls the number of branches 
each arc forms; higher values generally yield 
more branching. Because branching is a random 
process, Branching will sometimes have more 
effect  than others. Clicking Random Seed may 
create more branches when Branching does not.

Note: Branching is randomly controlled by the 
Branching, Branch Spread, and Random Seed 
parameters. A small change made to any of these 
controls can have an unpredictable effect  on the 
number and distribution of branches.

Branch Spread Controls how far apart  the 
branches are spaced; higher values increase the 
angle between branches.

The effect of increasing branch spread.

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.
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Glow Tab
Flash Size Specifies the size of the glowing flash 
that  begins the arc of lightning. With Taper 
Main Arc disabled, both the beginning and 
endpoints of the arc have flashes

Glow Width Controls the diffuse glow around 
the arcs. Increasing this value spreads the glow 
over a wider area.

Glow Opacity Increasing this value yields a 
darker, less transparent arc. 

Inner and Outer Color The glow at  the middle 
of each arc starts as the Inner Color and fades 
to the Outer Color as it  moves outward. Clicking 
in either box brings up a color picker dialog.
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Chapter 10: Little Fluffy Clouds

Litt le Fluffy Clouds creates a wide range of cloud 
shapes and cloud-like effects, from slight  wisps 
to threatening storm fronts. The clouds can be 
rendered with a horizon perspective for use in 
photos or as t ileable two-dimensional clouds 
that make great  backdrops. We recommend that  
you test  drive the filter using presets, to survey 
the wide variety of cloud simulations that  this 
filter can render. 

Using Little Fluffy Clouds
To render perspective clouds:

1 Select  the area to which you would like to add 
clouds. 

2 Run the Lit t le Fluffy Clouds filter.
Note: If you are adding clouds to a photo, it  is 
advisable to leave the Draw Sky Background 
option cleared.

3 In the Camera Tab, enable Perspective.

4 Play with the basic features of the filter, then 
the camera features, until you are satisfied 
with the result .

5 Click OK.

6 Sit  back and gaze contentedly upon your 
creation.

To render clouds that  do not have a horizon 
perspective:

1 Select  the area to which you would like to add 
clouds. 

2 Run the Lit t le Fluffy Clouds filter.

3 In the Camera Tab, disable Perspective.

4 Play with the basic features of the filter and 
optionally the sky color features.

5 If you are using the clouds to t ile a 
background, such as a Web page, enable the 
Seamless Tile option.

6 Click OK.

7 Be amazed.
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Control Descriptions

Basic Tab
Puff Size Controls the size of the cloud puffs 
created across your selection; higher values 
yield larger and fewer clouds.

Coverage Higher values cover your image more 
completely and smaller values leave more gaps 
in the clouds.

Edge Sharpness Controls the sharpness of the 
clouds’ edges; lower values yield softer, less 
defined clouds.

Base and Edge Color The clouds are made up of 
two colors. Clouds are the Base Color in central 
opaque areas and fade to the Edge Color in 
surrounding semi-transparent  areas. Clicking in 
either box brings up the color picker you have 
previously selected in your graphics program.

Cloud Mode Select  the basic cloud type, then 
refine the effect with the other filter control 
parameters. The following three modes are 
available:

• Fluffy

• Wispy

• Puffy

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 

effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Sky Color Tab
Draw Sky Background Choose this option to 
draw a sky background over the original image. 
When cleared, the rest  of the Sky Color Tab is 
disabled. 

Zenith Color Specify the color of the zenith 
using your color picker.

Horizon Color Specify the color of the horizon 
using your color picker.

Haze Simulates dust  or smog, which obscures 
the clouds. Higher values fade the clouds more.
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Sky Gradient Controls how high the Horizon 
Color extends into the sky before transit ioning 
into the Zenith Color.

The effect of increasing Sky Gradient. The zenith is black 
and the horizon is white.

Camera Tab
Seamless Tile Select  the Seamless Tile 
checkbox to create a repeating pattern with no 
seams. Selecting Seamless Tile disables the rest  
of the Camera Tab controls.

Perspective Select  this option to draw a 
perspective view of the clouds. Clearing this box 
disables View Elevation, Field of View, and 
Cloud Height.

View Elevation Specifies the angle at  which the 
camera is t ilted, relat ive to a horizontal posit ion 
of 0 degrees. Zero degrees is the bottom of your 
selection and is a view straight across the 
horizon from a standing posit ion. The maximum 
angle of 90°  looks straight into the sky from a 
flat-on-the-back posit ion. Anywhere in between 
is like falling backward from a standing 
posit ion. 
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Field of View Controls how much of the sky is 
captured by the camera. Higher values show 
more of the sky. Low values show only a t iny 
portion of the sky.

Cloud Height Controls the height  of clouds in 
the sky. Higher values increase the apparent 
height  and reveal more of the sky.
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Chapter 11: Puzzle

Puzzle creates a jigsaw puzzle effect over your 
image, using highlights and shading. You can 
knock out pieces of the puzzle, invert  
connecting nubs, and replace knocked out 
pieces with color or transparency.

Using Puzzle
Note: Puzzle is easiest  to use on entire images 
or rectangular selections. Round selections will 
cut  off parts of the puzzle effect. 

1 Run the Puzzle filter.

2 Play with the basic features of the filter—set 
up columns, knock out pieces, and futz with 
connecting nubs. 

3 When you are sat isfied, click OK.

4 Have a comforting beverage and pat  yourself 
on the back for a job well-done.
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Control Descriptions

In Preview Controls
Clicking the arrow cursor in the Puzzle interface 
activates the In Preview controls. Puzzle 
provides three context-sensit ive In Preview 
controls, each with a dist inctive cursor:

• (A)  Knockout Piece—When you mouse over a 
puzzle piece, this cursor appears. Click on the 
piece to delete it .

• (B)  Restore Piece—When you mouse over a 
deleted piece this cursor appears. Click the 
empty space to restore the piece.

• (C)  Invert  Connector—If you think that  a 
connecting nub would look better reversed, 
click on that  nub when you see this cursor.

Note: Multiple In Preview control cursors will 
not  be active simultaneously. The cursors have 
been magnified in the image below for better 
visibility.

Connecting Nub

Click the arrow to activate
the In Preview controls.

A
B

C
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Basic Tab
Columns Controls the number of columns drawn 
over the select ion. Higher values yield more 
columns and smaller pieces. The number of rows 
is automatically determined to create puzzle 
pieces that  are as square as possible.

Knockout 10% Remaining Deletes approxi-
mately 10% of the remaining puzzle pieces each 
t ime you click the button. 

Restore All Pieces Did you go a lit t le crazy 
knocking out pieces? That ’s OK. Just  click this 
button to restore them all. Note: You also have 
unlimited undos in Xenofex 2; if you want to 
backtrack sequentially, use your old friend 
Control-Z (Windows) or Command-Z 
(Macintosh).

Invert All Pieces Click to restore any pieces 
that have been knocked out while simulta-
neously knocking out all active pieces.

Randomize Connectors Randomizes the direc-
t ions in which puzzle piece connectors face. If 
you see too many repeating patterns in the 
connectors, give this bad boy a click.

Connector Length Increases the length of the 
connecting nubs that  connect puzzle pieces. 
There’s no science to this; just  go with what 
looks best .

Groove Width Specifies the width of the 
bevelled trench between puzzle pieces. Higher 
values increase the width.

Knockout Fill

Fill with solid color Fills the knocked out areas 
with the color chosen using the Fill Color 
picker. 

Make knockouts transparent Fills the knocked 
out areas with transparency. This option is 
disabled when the selection is in a background 
layer.

Connector Shape Random Seed Controls the 
random variations in connector shapes. Give 
Random Seed a couple of clicks; if you find an 
effect  that  you like, save it  as a set t ing so you 
can reproduce the effect  later.

Lighting Tab
Groove Darkness Darkens the trenches between 
puzzle pieces. Higher values make the trenches 
darker.

Light Direction Controls the direction from 
which the light falls on your selection. Click and 
drag within the lighting control box to change 
the direction, or enter a numerical value 
between 0 and 360 degrees.

Highlight Brightness Controls the intensity of 
the shiny highlights appearing on the bevelled 
areas facing the light .

Highlight Size Controls the size of the shiny 
highlights on the bevelled areas facing the light; 
higher values yield larger highlights.
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Chapter 12: Rip Open

Rip Open simulates a paper surface being torn, 
punctured, or blown open. 

Using Rip Open
1 Using a selection tool, preferably the lasso or 

the elliptical marquee tool, make a selection 
around object  or spot that  you want to rip 
open.

2 Run the Rip Open filter.

3 Adjust the sliders to taste.

4 Have a siesta; you deserve it .

Control Descriptions
Curl Size Controls the width and number of the 
curled pieces. Higher values yield wider and 
fewer pieces.
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Curl Amount Specifies the distance to pull back 
curled pieces. Higher values peel the pieces back 
further. 

Curl Variation Randomizes the curl sizes, 
direction, and amount of curling. Higher values 
further randomize the these features.

Edge Roughness Adds roughness to the edges 
of the curled pieces. Higher values result  in a 
tat tered appearance.

Shadow Width Specifies the width of the 
shadows cast  by the curls. Higher values yield 
wider shadows.

Inside Fill

Fill with solid color Fills the torn out areas with 
the color chosen using the Fill Color picker.

Make selection transparent Fills with trans-
parency to reveal the underlying layer. Disabled 
if the image is in the background layer.

Same Color on Underside Selecting this option 
draws the original image on the underside of the 
curls. Disables Underside Color.

Underside Color Use the color picker to select  a 
color for the underside of the curls.

Same Color on Underside has been selected in the image 
above with a high curl variation setting.

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.
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Chapter 13: Shatter

Shatter explodes images and selections into 
lit t le pieces and shards that  fly off the page in a 
three-dimensional simulation of an exploding 
surface.

Using Shatter
Note: Shatter does not work in CMYK mode.

1 Select  the area that  you want to shatter. To 
shatter the entire image, leave it  unselected. 

2 Run the Shatter filter.

3 Experiment with the control sliders freely, 
until you are sat isfied with the result .

4 Click OK.

5 Think good thoughts.
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Control Descriptions

Basic Tab
Piece Size Controls the average size of the 
broken pieces. Increasing this value makes the 
average shattered piece larger.

Thickness Controls the three-dimensional 
depth of each piece. Higher values yield thicker 
pieces.

Tumble Controls the random rotation and 
spreading of shattered pieces. As this value 
increases, pieces spread further apart , 
sometimes flying out of the field of view.

Time Specifies the amount of t ime that  has 
elapsed in the shatter event. A value of 1 is the 
very beginning of the event, and all you can see 
are surface cracks forming. As t ime moves 
forward, pieces fly away from the original 
surface and rotate.

The sequence above demonstrates the effect of Time on a 
shattered image.

Shadow Opacity Controls the opacity of drop 
shadows cast  by the broken pieces. Higher 
values yield darker shadows.
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Shadow Blur Width Controls the opacity drop-
off at  the edge of shadows. Higher values yield a 
wider area of blurring, suggest ing a light source 
that is farther away.

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Lighting Tab
Increase Contrast Boosts the lighting effect  on 
shattered pieces, yielding brighter, harsher 
lighting.

Light Direction Controls the direction from 
which the light falls on your selection. Click and 
drag within the lighting control box to change 
the direction, or enter a numerical value 
between 0 and 360 degrees.

Highlight Brightness Controls the intensity of 
the shiny highlights appearing on the areas 
facing the light .

Highlight Size Controls the size of the shiny 
highlights on areas facing the light; higher 
values yield larger highlights.
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Chapter 14: Stain

Stain creates a realist ic stain effect in the shape 
of any selection. You can emulate spaghett i 
sauce, coffee cup rings, motor oil, sweat and 
more! 

Using Stain
Note: Use Stain with a selection to get  the best  
effect . Using Stain without a selection fills the 
entire image or, with Ring Stain selected, 
creates a border around the edge of an image.
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1 Using a selection tool, such as the type mask 
tool, or the lasso, select  the object  or area that  
you wish to stain.

2 Run the Stain filter.

3 Adjust  the filter controls to taste.

4 Click OK.

5 Enthusiast ically beat  your chest .

Control Descriptions
Ring Stain Select  this check box to apply the 
stain effect  to the area around your selection 
boundary. For example, applying Stain to a 
circular selection with Ring Stain selected 
creates a stained loop, like a coffee mug might  
leave behind. 

Clearing the Ring Stain check box fills the ring 
using the color selected in Stain Color and 
opacity levels set  with the Internal Opacity and 
Overall Opacity sliders.

Edge Width Specifies the width of the opacity 
drop-off, which forms the stain effect . Higher 
values produce a wider stain. 

Roughness Controls the roughness of the stain 
edge; higher values produce an increasingly 
jagged edge.

Internal Opacity Controls the transparency of 
the inner part  of the stain. Higher values 
increase the opacity of the stain’s interior.

Overall Opacity Controls the opacity of the 
entire stain effect . Higher values darken the 
stain effect  and interior opacity (if an internal 
opacity above one has been specified).

Stain Color The stain can be any color you like. 
Clicking in this box awakens your slumbering 
color picker.
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Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed set t ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Tips
Stain is designed to work with selec-
t ions. If you apply Stain without a 
select ion (when the Ring Stain 
check box is cleared) the stain will 

cover your entire image, producing an under-
whelming effect . 

In defiance of the above edict , apply 
stain to an entire image, with the 
Ring Stain check box cleared to 
create a picture frame.
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Chapter 15: Television

Television makes images appear as if they were 
displayed on an old television, display device, or 
computer monitor. A wide range of video-like 
distort ions are possible. Using the monochrome 
screen option can be used to simulate old 
computer monitors, for example.

Using Television
Note: Television works best on rectangular 
images and selections. It also works well with 
rectangular objects in layers.

1 Make a rectangular selection, using the 
marquee tool or select  the entire image to 
which you will apply Television. 

2 Run the Television filter.

3 Adjust  the control sliders until you have 
achieved the desired effect .

4 Click OK.

5 Enjoy.

Control Descriptions
Scanline Strength Creates dark bands like those 
seen on old television monitors; higher values 
yield darker bands.

Scanline Thickness Controls the width of the 
dark and light  bands; higher values yield thicker 
but  fewer bands.

Vertical Shift Places a black band at  the bottom 
of the selected area, then shoves the image 
upward, looping it  back through the bottom of 
the selected area. This effect  simulates the loss 
of vert ical hold on an old TV. Higher values push 
the image further. A value of 100 nearly 
completes the loop, rendering an image similar 
to a zero value. 

Curvature Simulates the distort ion caused by 
curved picture tubes; higher values increase the 
curvature. If you use a high Curvature set t ing 
on a selection in the background layer, your 
background color will show around the edges of 
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your selection. You can avoid this by copying 
the image to its own layer and applying 
Television there.

Static Controls the amount of visual noise 
added to the image. Higher values yield a more 
noisy and colorful image.

Ghost Strength Creates a faint , shifted copy of 
the image. Higher values produce a more 
obvious “ghost” copy.

Ghost Offset Controls the amount the image 
copy is shifted from the original; higher values 
yield “ghosts” farther away from their original 
posit ion.

Top to bottom: The effects of increasing breakup and ghost 
offset. Ghost strength levels are set high.
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Breakup Adds random horizontal shift ing to 
your image; higher values yield a wavier, 
broken-up image.

Monochrome Screen Selecting the 
Monochrome Screen check box yields a two-
color effect . You can convert  color distort ions to 
black-and-white, amber (like old computer 
monitors), or anything else. This option is 
cleared by default .

Monochrome Screen Color Use this color picker 
to choose your screen color when the 
monochrome screen check box is selected. 

Background Color Chooses the solid color that 
fills the areas where the effect  does not cover 
the original image. This is only enabled in the 
background layer. In layers that have trans-
parency, the area around the effect  is simply 
erased.

Random Seed Controls the random element in 
the creation of this effect. Minor changes in the 
Random Seed sett ing can produce dramatic 
changes in your image; we encourage you to 
experiment with this control until you find the 
effects you like best . You can then precisely 
duplicate the effect  by saving the Random Seed 
sett ing.

Tips
Apply Television only to rectangular 
selections, images, or objects. Using 
rounded selections yields unexpected 
results!

Use Amber or Green to emulate the 
look of ancient  computer monitors. 
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Chapter 16: Troubleshooting
We have tried to collect  the most  commonly-
asked questions here. A regularly updated 
troubleshooting guide can be found in the 
Support  section of our Web site. If you get  really 
stuck, send E-mail to support@alienskin.com. 
Include in the E-mail your 12 let ter registrat ion 
code, whether you are using Mac or Windows, 
and your graphics host  program (Photoshop, 
Paint  Shop Pro, etc.).

This chapter covers the following trouble-
shooting issues:

• “Installat ion Problems” on page 57

• “Performance Issues” on page 59

• “Error Messages” on page 61

Installation Problems
Problem The installer won't  accept my 12-let ter 
registrat ion code, or I can't  find my code. 

Solution—If you can’t find your code

The Product Registrat ion Code (serial number) is 
a 12-let ter code located in one of the following 
three places:

• Your user manual (physical version). 

• On the CD jewel case (physical version). 

• On the download page and in an email invoice 
(electronic version).

If you’ve registered the software with us (by 
purchasing directly from us, registering online 
or sending in a registrat ion card), we’ll have the 
code in our database. If you didn’t  register with 
us, contact  us at  support@alienskin.com 
<mailto:support@alienskin.com> to get  regis-
tered and receive a new registrat ion code. 

Solution—If you have the code

1 Make sure that  you are entering the 12-let ter 
code and other registrat ion fields correctly. 
The registrat ion code should be all let ters with 
no spaces before or after the code. The Name 
field must contain at  least  three characters. 

2 Make sure that  you are using a Xenofex 2 code. 
Product  registrat ion codes are not  inter-
changeable. For example, your Eye Candy 4000 
code will not  work with Xenofex 2. You will 
need to use the new Xenofex 2 code that  you 
were issued when you purchased the software. 
This 12-let ter code can be found on web page 
from which you downloaded the software, in 
an email invoice you received while 
downloading the product, or on a st icker 
inside the front  cover of the manual.

Problem When I try to install Xenofex 2, I get  
an error dialog saying that  I don’t  have privi-
leges or permission to install the software.
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Solution The Xenofex 2 installer, like most 
installat ion programs, will need to write files to 
various folders on your computer. With 
operat ing systems such as Mac OS X, Windows 
2000 and Windows XP, you will need to have 
administrator privileges. For information on 
configuring your user account for such privi-
leges, see your system administrator or your 
operating system manual.

Problem After installing the plug-ins and 
start ing the graphics host  program, the filters 
do not appear in the Filter or plug-in menu.

Solution The filters were probably not installed 
in your graphics program’s plug-in folder. Find 
out exactly which folder your host  program is 
using for plug-ins. With Photoshop, you can 
determine this by going to Edit > Preferences 
> Plug-ins. Then try to install the filters again 
and make sure you select  the proper plug-in 
folder. Also, remember that  after installing new 
filters, you must restart  your graphics program 
for them to become available. With other 
graphic host  programs, consult  that  program’s 
manual for more information about where plug-
ins need to be installed and how to access them.

Problem: Xenofex 2 doesn’t  work with a 
graphics program that claims to use Photoshop 
plug-ins.

Solution: Programs sometimes claim to work 
with all Photoshop plug-ins without test ing 
thoroughly or strict ly following the Photoshop 
plug-in standard. If you’d like to use Xenofex 2 

with a host  not  listed in this manual, please 
visit  our Web site for the latest  list  of compatible 
hosts.

Problem: How do I uninstall Xenofex 2?

Macintosh OS 9/ Classic Solution: Find the 
Xenofex 2 folder in your graphics program’s 
plug-in folder and delete it . Also delete the 
Application Support : Alien Skin : Xenofex 2 
folder.

If the multiple users control panel is enabled, 
you’ll also need to delete the Users : <user 
name> : Application Support : Alien Skin : 
Xenofex 2 folder.

If the multiple users control panel is disabled, 
you’ll also need to delete the System Folder : 
Application Support : Alien Skin : Xenofex 2 
folder.

Macintosh OS X Solution: Find the Xenofex 2 
folder in your graphics program’s plug-in folder 
and delete it . Also delete the / Users/ <user 
name>/ Library/ Application Support/ Alien 
Skin/ Xenofex 2 folder.

Windows Solution: Run Add/ Remove 
Programs from your Windows Control Panel. 
Select  Xenofex 2 from the program list  and click 
the Add/ Remove button. This will remove the 
program and most of its components. Next go to 
your plug-ins folder and delete the Xenofex 2 
Settings folder.
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Performance Issues
Problem Running Photoshop 7 under OS X, 
when I use the color picker in an Xenofex 2 
filter, the effect  doesn’t  apply. 

Solution The effect  has been applied, but  the 
view window is not being updated. There are two 
ways to kick this recalcitrant  window into gear:

1 Before you run the filter, select and use the 
Apple color picker, rather than the Photoshop 
color picker (select  this under the General tab 
in the Preferences dialog).

2 If you have already used the Photoshop color 
picker, zoom in and out to update the image. 

Problem Some or all of the filters appear grayed 
out in the Filter menu.

Solution Grayed-out filters in the Filter menu 
occur if you are in certain color modes (such as 
CMYK, Lab or Bitmap) that won’t  allow a specific 
filter to work properly.

Problem One of the filters seems to have no 
effect  on the image.

Solution You may have selected a layer that  is 
hidden by other layers when Show all Layers is 
enabled. Deselect  the Show all Layers checkbox 
in the View menu in your filter interface. 

Problem I get  a message that  Xenofex 2 ran out 
of memory while rendering the preview.

Solution In Photoshop, the history palette and 
other features take up a lot  of memory. You can 
free up this memory by selecting Edit > Purge > 
All.

Problem The preview seems broken. It  only 
shows the checkerboard pattern.

Solution Sometimes the preview begins in a 
transparent part  of a layer. Click an opaque area 
of your selection in the navigation thumbnail.

Problem A filter makes the graphics program or 
the entire computer crash or freeze up.

Mac OS 9/ Classic Environment Solution Make 
sure that you have allocated enough memory to 
your image edit ing program. The default  
memory allocation may not be enough, 
especially if you are working with print  
resolution images. You can increase the memory 
allocation by exit ing the image editor and 
performing a Get Info on the program icon in 
the Finder. 

If you are using Photoshop, the history palette 
and other features take up a lot  of memory. You 
can free up this memory by selecting Edit > 
Purge > All from the Photoshop menu.

To determine whether you have an extension 
conflict , restart  your Macintosh while holding 
down the Shift  key. You may release the Shift  
key after you see the message “Welcome to 
Macintosh. Extensions off.” Then try the same 
filter operation. If it  now works, then you have 
a control panel or extension installed in your 
computer that  is incompatible with Xenofex 2. 
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We will love you very much if you try to identify 
the problem extension and inform us of the 
conflict .

Mac OS X/ Windows Solution Sometimes 
freezes or crashes occur when your computer 
runs out  of available memory. If you are using 
Photoshop, you can sometimes free up large 
amounts of memory by select ing Edit > Purge > 
All.

Also, make sure that  your computer system has 
the minimum requirements to run our software. 
You also should try exit ing out of other 
programs before you run your image edit ing 
program, as there might  be a conflict  between 
another program and Xenofex 2. If you notice 
such a conflict , we will love you very much if 
you try to identify the problem program and 
inform us of the conflict .

Also, make sure that  your computer system has 
the minimum requirements to run our software. 
You also should try exit ing out of other 
programs before you run Photoshop, as there 
might  be a conflict  between another program 
and Xenofex 2 If you notice such a conflict , we 
will love you very much if you try to identify the 
problem program and inform us of the conflict .
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Error Messages
The table below provides remedies to the error messages you may encounter in Xenofex 2.

Error Message User Remedy

This host  application does not  support  enough of 
the Photoshop filter specificat ion for this filter to 
run.

Sorry! Your host  graphics program is incompatible with Xenofex 2. Consult  the 
list  of compatible host  programs in “Host Requirements” on page 2.

This filter requires a select ion. Make a select ion, then rerun the filter.

This filter requires editable transparency. Please turn 
OFF Preserve Transparency in the Layer palet te.

In Photoshop 6, turn off the Preserve Transparency option in the Layers Palet te. 
In Photoshop 7, clear the Lock Transparent Pixels button.

This filter only runs on MacOS 9 or later. Check the operating system requirements for Xenofex 2 in your user manual. 
Xenofex 2 only works with MacOS 9 or later.

The filter ran out  of available memory while render-
ing the preview image.

The history palet te and other features take up a lot  of memory. In Photoshop, you 
can free up this memory by select ing Edit > Purge > All.

You may not  have enough physical memory (RAM) to handle the image that  
you’re working with.

A serious error occurred and the filter was unable to 
find the entry point  for the core library. Reinstalling 
the filters may fix this problem.

Reinstall Xenofex 2.

A serious error occurred and the filter was unable to 
load the core library. Reinstalling the filters may fix 
this problem.

Reinstall Xenofex 2.

A serious error occurred and the filter was unable to 
set  the location of its resources. Reinstalling the fil-
ters may fix this problem.

Reinstall Xenofex 2.

The regist rat ion code was not installed or is invalid. 
Please reinstall the filters.

Reinstall Xenofex 2.

Please make a select ion or an object  in a layer that  
does not  take up the entire layer.

Make a select ion or place an object  in its own layer with surrounding transpar-
ency to make the filter run.

Sett ing names can only include let ters, numbers and 
spaces, and must  be 31 or fewer characters in length.

Reduce the length of your sett ing name and make sure that  it  only contains let -
ters, numbers, or spaces.
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License Agreement
This is a legal agreement (the "Agreement") between you (either an individual or an entity), the end-
user, and Alien Skin Software LLC ("Alien Skin"). By installing the computer software in this package 
("SOFTWARE"), by loading or running the SOFTWARE, or by placing or copying the SOFTWARE onto 
your computer hard drive, you are agreeing to be bound by the terms of this Agreement. If you do 
not agree to the terms of this Agreement, promptly return the SOFTWARE and the accompanying items 
(including all writ ten materials), along with your receipt  to the place from where you obtained them 
for a full refund.

ALIEN SKIN LICENSE

1. GRANT OF LICENSE. Alien Skin grants to you the right  to use one (1) copy of the enclosed SOFTWARE 
on a single computer. For purposes of this section, "use" means installing the SOFTWARE into RAM, 
as well as installat ion on a hard disk or other storage device. You may make multiple installat ions of 
the SOFTWARE on a single computer; provided that , each installat ion of the SOFTWARE is for use with 
a different application. You may not: rent , lease, distribute, modify, translate, disassemble, 
decompile, reverse engineer, or create derivative works based upon the SOFTWARE. The SOFTWARE, 
together with any archive copy thereof, shall be either returned to Alien Skin or destroyed when no 
longer used in accordance with this Agreement, or when the right to use the SOFTWARE is terminated.

2. COPYRIGHT. The SOFTWARE is owned by Alien Skin and is protected by United States copyright laws 
and international treaty provisions. You must treat  the SOFTWARE like any other copyrighted 
material, except that  you may either (a) make one copy of the SOFTWARE solely for back-up or 
archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original 
solely for back-up or archival purposes. You may not otherwise reproduce, copy or disclose to others, 
in whole or in any part , the SOFTWARE. You may not copy the writ ten materials accompanying the 
SOFTWARE.

3. OTHER RESTRICTIONS. This Agreement is your proof of license to exercise the rights granted herein 
and must be retained by you. You may not rent  or lease the SOFTWARE, but you may transfer your 
rights under this License Agreement on a permanent basis provided you transfer this License 
Agreement, the SOFTWARE, and all accompanying writ ten materials and retain no copies, and the 
recipient  agrees to the terms of this Agreement. Any transfer of the SOFTWARE must include the most 
recent update and all prior versions. 
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4. GENERAL PROVISIONS. Should any provision of this Agreement be held to be void, invalid, 
unenforceable or illegal by a court , the validity and enforceability of the other provisions shall not  
be affected thereby. If any provision is determined to be unenforceable, you agree to a modification 
of such provision to provide for enforcement of the provision’s intent , to the extent  permitted by 
applicable law. Failure of a party to enforce any provision of this Agreement shall not  constitute or 
be construed as a waiver of such provision or of the right  to enforce such provision. If you fail to 
comply with any terms of this Agreement, YOUR LICENSE IS AUTOMATICALLY TERMINATED.

LIMITED WARRANTY

LIMITED WARRANTY. Alien Skin warrants that  if properly installed and operated on a computer for 
which it  is designed, the SOFTWARE will perform substantially in accordance with the accompanying 
writ ten materials for a period of ninety (90) days from the date of receipt .

CUSTOMER REMEDIES. Alien Skin’s entire liability and your exclusive remedy shall be, at  Alien Skin’s 
option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that does not 
meet Alien Skin’s Limited Warranty. To make a warranty claim, return the SOFTWARE to the point  of 
purchase, accompanied by proof of purchase, your name, your address, and a statement of defect , or 
return the SOFTWARE with the above information to Alien Skin. This Limited Warranty is void if 
failure of the SOFTWARE has resulted in whole or in part  from accident , abuse, misapplication or 
violation of this Agreement. Any replacement SOFTWARE will be warranted for the remainder of the 
original warranty period or thirty (30) days, whichever is longer. This warranty allocates risks of 
product failure between you and Alien Skin. Alien Skin’s product pricing reflects this allocation of 
risk and the limitat ions of liability contained in this warranty.

NO OTHER WARRANTIES. ALIEN SKIN DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING WRITTEN 
MATERIALS. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS 
WHICH VARY FROM JURISDICTION TO JURISDICTION. ALIEN SKIN DOES NOT WARRANT THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED, ERROR FREE OR MEET LICENSEE’S SPECIFIC 
REQUIREMENTS. THE WARRANTY SET FORTH ABOVE IS IN LIEU OF ALL OTHER EXPRESS WARRANTIES 
WHETHER ORAL OR WRITTEN. THE AGENTS, EMPLOYEES, DISTRIBUTORS, AND DEALERS OF ALIEN SKIN 
ARE NOT AUTHORIZED TO MAKE MODIFICATIONS TO THIS WARRANTY, OR ADDITIONAL WARRANTIES ON 
BEHALF OF ALIEN SKIN SOFTWARE. ADDITIONAL STATEMENTS SUCH AS DEALER ADVERTISING OR 
PRESENTATIONS, WHETHER ORAL OR WRITTEN, DO NOT CONSTITUTE WARRANTIES BY ALIEN SKIN AND 
SHOULD NOT BE RELIED UPON.
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EXCLUSIVE REMEDIES. You agree that  your exclusive remedy against  Alien Skin, its affiliates, 
contractors, suppliers, and agents for loss or damage caused by any defect  or failure in the SOFTWARE 
regardless of the form of action, whether in contract , tort , including negligence, strict  liability or 
otherwise, shall be the return of the purchase price paid or replacement of the SOFTWARE. This 
Agreement shall be construed in accordance with and governed by the laws of the State of North 
Carolina. Copyright  and other proprietary matters will be governed by United States laws and inter-
national treaties. IN ANY CASE, ALIEN SKIN SHALL NOT BE LIABLE FOR LOSS OF DATA, LOSS OF 
PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR 
DAMAGES ARISING FROM BREACH OF WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, OR OTHER 
LEGAL THEORY EVEN IF ALIEN SKIN SOFTWARE OR ITS AGENT HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. Some jurisdict ions do not allow the 
exclusion or limitat ion of incidental or consequential damages, so the above limitat ion or exclusion 
may not apply to you.

VIOLATION OF AGREEMENT. If you breach the provisions of this Agreement, you will be liable to Alien 
Skin for all damages, losses, cash, and expenses incurred by Alien Skin as a result  of such breach, 
including lost  profits and all the incidental and consequential damages.

U.S. GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject  to restrict ions as set  forth in subparagraph (c)(1)(ii) of the 
Rights in Technical Data and Computer Software clause at  DFARS 252.227-7013 or subparagraphs 
(c)(1) and (2) of the Commercial Computer Software-Restricted Rights at  48 CFR 52.227-19, as appli-
cable. Contractor/ manufacturer is Alien Skin, 1111 Haynes Street, Suite 113, Raleigh, North Carolina 
27604-1305.
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